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1 Using This Document 
The DatuSite™ User Guide will help you: 

 Understand the principles of operation of the software packages available from Datumate. 

 Plan and execute your fieldwork. 

 Use the software, calculate volumes, and generate 3D Point Clouds and orthophotos from 
the images taken in the field. 

 
 

Within this document, you will find comments, tips and answers to frequently asked questions. 
These are indicated by the following admonitions: 

 This icon signifies comments that are important for the user. They will help you to 
make the maximum use of the DatuSite™ software. 

 

This icon signifies operational tips that may help you optimize your work in the field 
and in the office. 

 

 This icon signifies warnings that are important for the user. 
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2 Overview of DatuSite™ Packages 

2.1 Background 
DatuSite™ software is an application allowing construction companies to make volumetric 
analysis of stockpiles as well as generating Orthophotos with precise measurements . 

This manual describes the full functionality of all features covered by the package. 

2.2 Principles of Operation 
The DatuSite™ software employs the principles of 
photogrammetry. Photogrammetry is the science of taking 
accurate measurements from photographs. The output of 
photogrammetry is typically a CAD map, plan, a drawing, or a 3D-
model of some real-world object or scene. 

 

Figure 1: Principles of Operation of DatuSiteTM 

DatuSite™ automatically calculates the internal camera system parameters using a simple 
automatic self-calibration procedure, thus allowing the user to use any regular digital camera 
(1 – Figure 1). When uploading the images, DatuSite™ employs image processing and bundle 
adjustment algorithms to automatically calculate the relative orientation of the images (2 and 
3 – Figure 1), such that only two of the images must be geo-referenced. Subsequently, DatuSite™ 
automatically locates any point the user marks on one image in at least two additional images 
(4 – Figure 1), thus allowing DatuSite™ to apply triangulation to find the 3D-coordinates of the 
new point. This permits users to draft objects directly on one image while the application 
automatically finds them in all other images, thus eliminating the need for stereoscopic 

“photo” – light 
“gram” – drawing 
“metry” – measurement 
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digitization of images. Moreover, DatuSite™ allows the automatic extraction of a digital terrain 
model (DTM) of the survey area. This is highly useful for topographic surveys and volumetric 
analyses. While drafting on the images, the surveyor may use templates containing layers and 
codes. Consequently, the generated 3D model of the survey area may be saved in CAD DXF file 
format, so that it can be opened for further processing in any CAD software package. 

As a result, DatuSite™ streamlines and accelerates the Field-to-Plan process, i.e., the process of 
capturing field data and the drafting of CAD maps and models from the data. 

2.3 Working with DatuSiteTM 

Working with DatuSite™ is very simple. 

1. Photograph the area of interest using a drone. 

2. Measure a few control points to geo-reference the images 

3. Analyze the photographed area and generate reports  

2.3.1  In the Field 

The user takes multiple photographs of the surveyed object or the survey area from different 
angles, and measures the coordinates of several (minimum of three) reference points (or 
control points) using a total positioning station (TPS) or an RTK device, in either a local or 
national grid, or alternatively measures two or more slope distances. The control points are 
used to geo-reference the images, i.e., anchor the images to the local or national grid, and the 
slope distances are used to correctly scale the whole project allowing the user to view correct 
measurements. 

2.3.2  In the Office 

The user uploads the images to the DatuSiteTM software. It automatically associates all images 
to one another, by employing advanced image processing algorithms that find homological tie 
points and similar features, calculating the relative orientation of the images. Optionally, the 
user can load the TPS measurement file of the control points and digitize at least three of the 
control points in at least two of the images each in order to geo-reference all images to the local 
or national grid. Alternatively, the user can choose to add scale-only without control points or 
geo-referencing (without orientation and position), by adding two slope distance 
measurements in two images each. Both geo-referencing and scale are optional, hence it is 
possible to build and see a model without measurements. 

Users may then generate a point cloud and mark stockpiles on the dense point cloud, or 
automatically generate a DTM for any topo-surface that appears in the images. The DatuSiteTM 
software ultimately shows the accuracy of each measurement, i.e. the (x,y,h) residuals for each 
control point. 

In addition, the user may opt to highlight, on the geo-referenced images, any additional points 
that were measured by field crews. In this way, the user may verify the quality of the 
measurements undertaken by field crews and identify and correct, in the office, any 
discrepancy in the field measurements. 
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Figure 2: Typical DatuSiteTM Work Area Showing Control Points 

2.4 Accuracy of Measurements 
In geo-referenced or scaled jobs, the accuracy of measurements made on the images by 
DatuSite™ depends on the following parameters: 

 The camera resolution and the distance between the camera and the measured 
object. The accuracy of measurements made on the images by DatuSite™ is a factor of the 
camera’s resolution and the proximity to the measured object. Typically, an 18-megapixel 
camera provides a 1 to 2 centimeter (3 to 6 hundredth of a foot) measurement accuracy at 
a distance of about 100 to 150 meters (110 to 160 yards, 330 to 480 feet). 

 The precision with which measurements in the survey area are done. This refers to 
the coordinates of the reference control points or to the measured distances. These should 
be as exact as possible as they set an accuracy baseline for all the measurement and drafting 
related to the images. When you measure ground control points, make sure you have 
several of them on a surface showing a very clear feature, such as marks on the ground or 
marks on walls. This will assure that a very precise measurement is taken. If you try to 
measure building corners using an RTK device you may have to slightly move away from 
the corner to make sure that the laser is indeed locked on the corner. 

 The maximum angle between images of the surveyed area. The accuracy of 
measurements made on the images by DatuSite™ is impaired when the maximum angle 
between images of the surveyed area is less than 30°. For best measurement accuracy, the 
maximum angle between images of the surveyed area should be close to 90°. This applies 
only when images are taken in oblique mode and not in vertical mode. 
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 The scattering of the control points or measured distances and the accuracy of 
digitizing them in the images. For best measurement accuracy, control points for image 
geo-referencing should be chosen on the perimeter of the surveyed area and measured 
distances should be as long as possible so that measurements made on the images by 
DatuSite™ are interpolated, rather than extrapolated, from the measured distances or 
points. Moreover, control points should be well distributed in 3D space, i.e., relative to both 
depth and height, and digitized as accurately as possible in the geo-referenced images. For 
more details on measuring control points in the field, please refer to Chapter 4. 

Various quality control measures in DatuSiteTM provide the user with detailed information 
about the accuracy of measurements. First, after the images have been geo-referenced, 
DatuSiteTM verifies the accuracy of the image geo-referencing or scaling by comparing the 
relative orientation of the control points or the distances to the relative orientation of the 
images. The Geo-Referencing Quality Indicator or Scale Quality Indicator provides a color 
indication (green, yellow or red) of the accuracy of the referencing of the photogrammetric 
model. Furthermore, after calculating the coordinates of the new points measured from the 
images, DatuSiteTM provides the accuracy of each measurement, i.e., the (x,y,h) residuals for 
every point. 



 

 
 

- 9 - 

3 Installing DatuSiteTM 

3.1 System Requirements 
The DatuSiteTM software is designed to work on commonplace office PCs and standard laptops. 

 Operating system requirements 

o Windows 7: Enterprise, Ultimate or Professional (64-bit only). 

o Windows 8.1: Enterprise or Professional (64-bit only). 

o Windows 10: Enterprise or Professional (64-bit only). 

 DatuSite™ works only under 64-bit operating systems. The 64-bit environment 
provides enhanced support for larger numbers of images and superior responsiveness. 

 CPU and hard disk requirements: 

o CPU: minimum Intel core i7. 

o CPU RAM: minimum 16GB RAM; recommended 32GB. 

o Hard disk: SSD 256GB with minimum 50GB of free space; recommended SSD 512GB 
with minimum100GB of free space. 

 Screen and graphics card requirements: 

o Display resolution: at least 1600X900 with True Color; recommended 1920x1080. 

 NVidia 750 GTX (required for DatuSite Enterprise); recommended NVidia 1070 GTX 
Connectivity requirements: 

o Available Internet connection for installation, activation and updates. 

 Compatibility: 

o DXF file format: DXF 2006 onwards. 

3.2 DatuSiteTM Licenses 

The following sections provide a general description of the licensing options. Some of the 
options mentioned below apply only to specific software packages. 

3.2.1  Stand-Alone Perpetual Software License 

A regular software license of DatuSiteTM allows the installation of one copy of the software on a 
single computer or “seat”. This copy of the software may be re-installed on that computer, or 
transferred to another computer after uninstalling from the first computer. This type of license 
has no expiration date and it includes maintenance for one year. The maintenance agreement 
will need to be renewed on a yearly basis after the first year. Maintenance includes support and 
software updates. 
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3.2.2  Stand-Alone Time-Based Software License 

A regular software license of DatuSiteTM allows the installation of one copy of the software on a 
single computer or “seat”. This copy of the software may be re-installed on that computer, or 
transferred to another computer after uninstalling from the first computer. This type of license 
has an expiration date after which the use of the software will not be possible unless the license 
in renewed. This type of license includes maintenance support up until the license expiration 
date. 

The system will notify you if your license is about to expire. 

3.3 Activating DatuSiteTM 
 If this is the first time the software is installed on your computer, the “DatuSite™ Activation 

License” will open. You should provide a license key file (V2C file that you receive from 
Datumate) or fill in the activation license request form. 

  

Figure 3: DatuSite™ Activation License 

 When you purchase a license the License ID (LicID) is provided with the invoice. Keep it for 
the activation step. 

 When the “Activation License Request” form is displayed fill in all the fields and click Send 
Request. 

 There are three types of licenses available: 

o Trial – this type of license is free of charge and lets you use the full power of 
DatuSite™ for a period of 30 days. A LicID is not required. 

o Full – this is a full purchased license of DatuSite™ for a single computer. It can be 
either perpetual or time-based. 

o Network – this is a full purchased license, allowing installation of DatuSite™ on 
several computers running on the same LAN (Local Area Network). 
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Figure 4: DatuSite™ Trial License Request Dialog Box 

 

Figure 5: DatuSite™ Full License Request Dialog Box 
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Figure 6: DatuSite™ Network License Request Dialog Box 

 You will receive your license activation file (V2C file) by email. This may take up to one 
business day. 

 Upon receiving the V2C, save it and when DatuSite™ starts, the “DatuSite™ Activation 
License” window (Figure 3) is displayed again. Click Load Activation File. 

 Browse to the location of the V2C license activation file and click on the file, thereby 
completing the activation process. 

 

Figure 7: Selecting the Licensing File 
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If you have purchased a Network License, you can manage a number of available 
concurrent DatuSite™ licenses by adding or removing LicIDs in the “Activation License Request” 
form (Figure 3). 

3.4 Reinstalling DatuSiteTM 

You may reinstall DatuSite™ on the same computer any number of times. The installation 
process is identical to the initial installation process, and no activation is required. 

However, if any hardware changes have been made on that PC, such as CPU or hard disk 
upgrades, you may need to re-activate the software license. The re-activation process is similar 
to that of transferring DatuSite™ to a different computer (refer to Section 3.5.) 

3.5 Transferring DatuSite™ to a Different Computer 
Each regular software license allows you to install the software on a single computer. You may 
transfer the software from one computer to another computer by contacting Datumate support 
in order to deactivate the original license and activate a new license on the new computer. 

3.6 Upgrading DatuSiteTM 
Datumate periodically releases software updates for DatuSiteTM. These updates include new 
functionality, compatibility to new operating system versions, bug fixes, and more. These 
updates are available for customers who are registered with Datumate’s Annual Support and 
Update Program. 

If you are eligible for software updates, it is highly recommended to install them as soon as they 
released by Datumate. Upon opening, the software will automatically check the availability of 
new versions and, if available, will notify the user about new version availability. Alternatively, 
to check for new software versions, click Help in the main menu and click Check for Updates. 

Checking for the availability of new versions requires Internet connectivity to 
Datumate’s website www.datumate.com. Please make sure you have proper Internet 
connectivity, and verify that your local Firewall does not block HTTP connection with 
Datumate’s website. 
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3.7 Updating License Key 

To update the license ID select the menu option Help/Update License ID which will show the 
following dialog. 

 

Figure 8: Updating License ID 

Simply copy and paste both License ID and License Key in the correct fields and click Update. 
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4 Field Work: Taking Photos and Measuring 
Control Points 

4.1 Choosing your Camera and Lens 

The following guidelines and recommendations will help you choose an optimal camera and 
lens for surveying work: 

Use a high-resolution camera. It is recommended to use a camera with at least an 18-
megapixel resolution. Typically, an 18-megapixel camera provides a 1 to 2 centimeter (3 to 6 
hundredth of a foot) measurement accuracy at a distance of about 100 to 150 meters (110 to 
160 yards, 330 to 480 feet). 

 DatuSite™ does not support images taken with cameras which have sensors greater 
than 36-megapixel because the application may not be able to contend with the resulting file 
size. 

 

 Use a camera with a large CCD/CMOS sensor. It is recommended to use a camera with a 
CCD/CMOS sensor size larger than 100 mm2. 
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Figure 9: Common CCD/CMOS Sensor Sizes Used by Digital Cameras 

A camera with lower resolution and smaller sensor size can be used but this will 
degrade the measurement accuracy and the performance of the automatic algorithms of the 
software. For example, an 8-megapixel compact or smartphone camera with a 40 mm2 sensor 
size will provide a measurement accuracy of 1 to 2 centimeter (3 to 6 hundredth of a foot) at a 
distance of only 30 to 40 meters (32 to 43 yards, 96 to 129 feet). 

 Use a lightweight camera with Wi-Fi connectivity. It is recommended to use a camera 
with a body weight lower than 300 grams and Wi-Fi connectivity. This facilitates easier 
installation and operation of the camera on telescopic poles or small UAVs. 

 Use a wide-angle lens. It is recommended to use a wide-angle lens with a fixed focal length 
between 8 and 16 mm. The wide angle provides a sufficiently broad field of view (FOV) to 
capture a spacious area when in close proximity to the target. This enhances the quality of 
measurements for images. 
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 Use a lens with a fixed focal length. DatuSiteTM requires that the camera’s focal length will 
not change after the calibration of the camera and during the photographing of the survey area. 
Thus, it is strongly recommended to use a fixed focal length lens, i.e., a lens without an optical 
zoom. 

 The recommended camera types that are particularly suitable for the requirements 
mentioned above are lightweight mirror-less digital cameras with interchangeable lenses 
and Wi-Fi connectivity. As of March 2016, the list of recommended camera models includes: 

o Sony A7R with full frame 35mm lens (36.4 megapixel, CMOS Sensor, 35mm 
format sensor = 861.6 mm2 sensor size, Wi-Fi connectivity, body weight 465 g) + 
Samsung 35 mm fixed lens. 

o Sony Alpha ILCE-A6000 (24 megapixel, mirror-less, interchangeable lens, APS-C 
format sensor = 370 mm2 sensor size, Wi-Fi connectivity, body weight 285 g) + Sony 
16 mm fixed lens. 

o Samsung NX Mini (21 megapixel, mirror-less, interchangeable lens, 1’’ BSI format 
sensor = 116 mm2 sensor size, Wi-Fi connectivity, body weight 158 g) + Samsung 9 
mm fixed lens. 

o DJI Phantom 3– Professional and DJI Phantom 4 (12 megapixels, 35mm format 
sensor, 20 mm fixed lens, FOV=94°). 

o DJI Phantom 4 Pro (20 megapixels, 1’’ CMOS format sensor = 116 mm2 sensor size, 
8.8mm fixed lens, FOV=84°). 

o DJI Inspire 1Pro (X5 - 16 megapixels, 15 mm fixed lens, FOV =72°). 

4.2 Photographing the Survey Area 

The following guidelines and best practices will help you photograph the survey area in an 
optimal way. Here you will find some general recommendations, as well as recommendations 
for taking oblique images and for taking vertical images. 

4.2.1  General Recommendations: 

 Use a drone to take images using Datumate’s automatic flight planner DatuFly™. This 
will increase the probability that images will be stitched into one cluster. 

 Make sure your images cover at least four ground control points (GCPs). Even though 
the minimum mathematical requirement to build a model is three GCPs, it is strongly 
recommended to use at least four. Thus, when control points are used, make sure that your 
images cover at least four with each one appearing in at least three images. 

 Set your camera to maximum resolution. Note that some camera models are preset to 
photograph in a resolution lower than their maximum resolution. Make sure your camera is set 
to the maximum resolution provided. 

 Make sure camera is set to save the GPS location of the images. This is essential for 
vertical images and recommended for oblique images. 

 Take your images in good and consistent lighting conditions. Take all images in similar 
lighting conditions, preferably at the same time of the day. Avoid photographing the survey area 
during different times of the day. This will minimize changes in shadings and lighting conditions 
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that may degrade the performance of the automatic image processing algorithms employed by 
DatuSiteTM. Do not take or use images of dark areas. 

 

Figure 10: Examples of Changes in Shadings and Lighting Conditions 

 If you use a zoom lens, do not change its settings while taking images. Modifying the 
zoom setting changes a camera’s calibration parameters. Thus, use a lens with a fixed focal 
length rather than a lens with zoom capabilities. However, if you do use a zoom lens, set it to 
the widest field-of-view and do not change this setting when photographing. 

4.2.2  Recommendations for Oblique Images: 

Oblique images will be used to survey small areas, intersections or façades. Normally such 
projects are considered small and the number of images taken is not substantial. 

 Assure that every point you want to measure appears in at least three images which 
have been taken at different positions. The key principle of photographing the survey area 
is that any point you want to measure should appear in at least three images from different 
viewing angles. The best measurement accuracy will be attained if the maximum angle of 
photography between the images is 90°. 
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Figure 11: Achieving Optimal Measurement Accuracy 

 Elevate the camera above ground level to minimize foreground obstructions hiding 
features surveyed. Elevating your camera above ground level is a key success factor for 
employing close-range photogrammetry. Elevating the camera above ground level helps 
avoiding low-lying foreground obstructions such as fences, cars, and near ground vegetation, 
thus generating images of the survey area with minimal obstructions. Moreover, some 
techniques used to elevate the camera above ground level, such as installing the camera 
onboard a small quad copter, allow a much faster process of photographing the surveyed area, 
thus significantly enhancing fieldwork productivity. 

Take photographs from an elevated vantage point, such as from the rear of a vehicle or from 
a building overlooking the survey area, or use a monopod to raise the camera several meters 
above ground level. Lightweight, portable telescopic poles intended for photography allow 
taking pictures from 6 to 10 meters (20 to 30 feet) above ground level. The camera can be 
controlled remotely by using the Wi-Fi function on a smartphone or a tablet. Another highly 
effective method to overcome obstructions is the use of small UAV copters. A UAV copter, 
flying at an altitude of 17 to 23 meters (50 to 70 feet), easily bypasses low-lying obstructions 
while the wide-angle lens of the camera (smaller than 16mm focal length) provides a very 
large field-of-view. 

 

Figure 12: Overcoming Low-Lying Obstructions 

 Modify the camera’s elevation for each image. This will ensure optimal measurement 
accuracy. 
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Figure 13: Modifying the Camera’s Elevation 

 Take images only in landscape format. DatuSiteTM does not support images in portrait 
format. If your camera is equipped with Auto Rotate functionality, set it on “Off” so that all 
images remain in landscape format. 

 

Figure 14: Correct and Incorrect Camera Positioning 

 Take a large number of images of the survey area from different viewing angles. The 
more images from different viewing angles you take of the survey area, the better the automatic 
algorithms will perform in associating the images and detecting new points. To achieve optimal 
results, take at least 20 to 30 consecutive images of your survey area from different viewing 
angles. It is possible to work with up to 500 or 700 images, depending on the image resolution, 
to cover a larger area. 

 Maintain a consecutive order of the images. While photographing the survey area, 
maintain a consecutive order of the images. This will ensure optimal performance of the 
automatic algorithms for associating images and detecting new points. If you do not do this you 
will need to manually order the images after loading them into the software which may be a 
lengthy process. 

 

Figure 15: Maintaining a Consecutive Order of Images 

 Surveying an object (façade, landmark, etc.). To survey an object, such as a façade or 
landmark, take 20 to 30 consecutive images as you walk along the object. Take a new image 
every few meters while keeping the camera centered on the center of the object. Elevate the 



 

 
 

- 21 - 

camera above ground level to minimize obstructions, and slightly modify the elevation of your 
camera between images. 

 

Figure 16: Surveying an Object 

 Surveying an area (intersection, bridge, etc.). To survey an area such as an intersection 
or bridge, take 20 to 30 consecutive images of the area’s perimeter. Take a new image every 
few meters while keeping your camera focused on the center of the surveyed area. Elevate the 
camera above ground level to minimize obstructions, and slightly modify the elevation of your 
camera between images. 

 

Figure 17: Surveying an Area 

 Recommendations for vertical images: Vertical images are used to survey large scale 
areas, stock piles, and long roads. Normally such projects are considered small and the number 
of images taken is not substantial. All projects that fall under this category should be 
photographed using a slalom path, meaning going back and forth taking images to cover the 
whole area. All images should be taken along the long flight paths. 

 Maintain proper overlap. It is recommended to maintain at least 75% front overlap and 
60% side overlap. 

 Surveying a long road. Defining the slalom flight trajectory over a road can be done in one 
of two ways, flying the long paths parallel to the road or across it. Flying parallel to the road 
permits taking less images, but it might cause traffic problems since one or more cars are 
travelling in the same direction of the drone, might appear in many of the images. While flying 
across the road will require more images, but traffic is easier to filter out. 
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 Keep projects manageable. To keep projects manageable divide them into sections or 
areas. For example, divide roads into sections of about 1500 meters (one mile) in length. Or if 
you have many stock piles, cover each or a few stock piles separately. Pay attention that in this 
version of DatuSite™ up to 500 or 700 images, depending on the image resolution, may be linked 
in one job, so you may want to take advantage of this feature when planning the project. 

4.3 Geo-Ref / Scale 

 

Figure 18: Selecting a Referencing System 

You can choose between Geo-Ref., Scale or Rough Scale as the referencing system for a specific 
job cluster. 

In order to select Geo-Ref, control point measurements from the field are required. These are 
marked on images in order to add position, orientation, and scaling to your output or 3D model. 

Scale selection allows you to add scaling to your output or 3D model without any special 
surveying tools. Scaling only is achieved by measuring two slope distances in the field and then 
marking each distance on two images each. It can be very useful for volume calculation since it 
requires scaling only and there is no need for position or orientation to calculate volume. 

Alternatively, it is possible to work without geo-referencing or scaling by selecting the Rough 
Scale option. This will basically allow you to start working on the model while ground control 
points or distances are being measured. When implementing this option you will need to mark 
one rough estimate of a distance on two images. This option can also be used for quickly 
generating views for different purposes such as presentations, where measurements are not 
necessary. In both Scale and Rough Scale mode you are also required to set the gravity direction. 

Finally, the Geo-Tag option allows you to use the image geo tagging data to set your scale and 
gravity options. This mode is also approximate and similar to the Rough Scale option. 

4.3.1   Measuring Control Points for Image Geo-Referencing 

The following guidelines and best practices will help you measure your control points in the 
survey area in an optimal way: 
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 Measure at least four control points in the survey area of a small project. At the 
minimum, each control point should appear in three of the images of the survey area, and which 
should be photographed from different angles or vertical locations, as close as possible to 90°. 
It is very strongly recommended to measure and mark four or more control points. 
Measuring and marking more control points in additional images will improve the resiliency of 
the geo-referencing process, assuming that the measurement of the control points is accurate 
itself. You may measure point coordinates in either a local or a national grid. The software will 
allow you to work with three control points marked in two images each. 

 

Figure 19: Measure at Least Three Control Points 

 Measure at least one control point every 40-50 meters on each side in elongated survey 
areas such as roads, and if possible, also try to measure points at different elevations. 

 Measure as many control points as possible of large scale areas. It is very important 
that you cover all safely reachable areas, especially on the perimeter of the area of interest. 

 Choose clearly defined control points. Choose control points that have a high contrast 
with the area around it and which will be unambiguously and accurately identifiable in the 
images. Use available landmarks or deploy your own prominent objects in the survey area if no 
appropriate landmarks are available. Good choices for control points are pointed shapes on flat 
surfaces such as painted street marks, or painted corners, tiles or stone patterns on building 
walls, etc. Corners of a building or tips of objects are only good for confirming the other control 
points. Avoid using extended objects as control points as well. 
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Figure 20: Choose Clearly Defined Control Points 

 Avoid measuring points on slanted surfaces. This is specifically important when using a 
Total Station with in reflector-less mode. 

 Accurately measure the position and elevation of the control points. Carefully measure 
the position and elevation of control points with an accuracy of better than 2 cm (0.79 inch). 
Make sure you mark the exact and not the approximate location of the measured points on the 
sketch. Remember, the accuracy of measuring the position and elevation of control points sets 
the accuracy baseline for all the measurements and drawings related to the images. 

 Scatter the control points in the survey area. To attain maximum accuracy, scatter your 
control points across the survey area relative to breadth, depth and height. Select control points 
on the perimeter of the survey area, so that measurements in the survey area are interpolated 
rather than extrapolated. Make sure that they are well scattered in the survey area. 

 Choose control points on more than one plane. To attain maximum accuracy, select 
points at both ground level and elevated positions. 

 

Figure 21: Choose Well-Scattered Control Points 

Make sure your control points are not all located on the same plane, such as at ground 
level or on a vertical flat façade. Choosing control points that lie all on the same plane will 
degrade the accuracy of the geo-referencing of the photogrammetric model. 
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Figure 22: Control Points Measured on Many Planes 

4.3.2  Measuring Distances for Image Scaling 

The following guidelines and best practices will help you measure distances in the survey area 
in an optimal way: 

 Measure at least two distances in the survey area. At a minimum, two distances should 
appear in two of the images of the survey area, which should be photographed from different 
angles, as close as possible to 90°. Measuring and marking more distances in additional images 
will improve the resiliency of the scaling process. 

 Choose clearly defined distances. Choose distances that will be unambiguously and 
accurately identifiable in the images. Good choices for distances are distances between pointed 
objects such as the corners of a building or street marks. 

 Accurately measure distances. Carefully measure the distances with an accuracy of better 
than 1 cm (0.4 inch). Remember, the accuracy of measuring the distances sets the accuracy 
baseline for all the measurements and drawings related to the images. 

 Choose distances on more than one plane. To attain maximum accuracy, select distances 
at both ground level and elevated positions. 
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5 Calibrating Your Camera 
Before processing your images with DatuSiteTM, it is important that you calibrate your camera, 
i.e., calculate the internal parameters of your camera and lens system. This includes the camera 
and lens focal length and radial distortions. DatuSiteTM takes the initial values of these 
parameters readjusting them to compensate for any changes in the camera’s internal 
parameters due to the automatic focus of the lens or environmental conditions such as ambient 
temperature changes. 

Note that the internal calibration parameters are different for different camera bodies and 
lenses, thus the calibration procedure should be repeated whenever a new camera body or lens 
is used. DatuSiteTM will save the calibration parameters of multiple cameras and lenses that you 
use. Also note that the calibration parameters change when using an optical zoom, and thus it 
is recommended to use lenses with a fixed focal length, i.e., not equipped with an optical zoom. 

Replacing your lens or using a new camera body requires recalibrating the camera and 
lens and saving the new calibration parameters in DatuSiteTM. 

 

As part of the installation process, predefined camera calibration parameters are 
available for some cameras and if you intend to use one of these cameras, you can save time by 
selecting one of the pre-calibrated calibrations. Despite using our best practices and the job 
results are not suitable, you may need to calibrate your camera rather than rely on the pre-
calibrated calibrations. Indications for that might be multiple clusters or poor accuracy. 

5.1 Calibration Procedure 
Calibrating the camera and lens includes the following steps: 

 Photographing the survey area or alternatively using a subset of images of a job to be 
processed. See Section 5.2 for best practice for taking or selecting images to be used in field 
calibration. 

The images can be sent to our support team who can create the calibration file for you. 
Then you can simply import it into your library and use it. To do so, send the images to 
support@datumate.com. 
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 Loading images to DatuSiteTM. 

 Getting initial camera parameters from one of the available sources including automatic 
extraction of internal parameters from images. 

 Running the calibration process and saving this new calibration. 

 Linking the images using the newly generated calibration file. 

 Adding floating control points in the Geo-Ref/Scale stage and using the “Apply” function to 
get an adjusted calibration. 

 Saving the final adjusted calibration to the calibration library. 

To calibrate your camera, simply follow these simple steps: 

 Click New Calibration... from the Images tab (Figure 23: left) or click Main Menu -> Tools 
-> New Calibration… (Figure 23: right). 

    

Figure 23: Selecting Mode of Calibration 

 

 Select one of the available sources for getting the initial camera calibration values in order 
to be able to run the calibration (Figure 24). 
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Figure 24: Selecting a Calibration Source 

 Adjust camera and lens parameters if needed, click Calibrate, and wait for the calibration 
process to end (Calibration Successful). 

 

Figure 25: Calibration Process 
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If an existing calibration is selected from the library or from an existing job, 
mismatches may occur due to incompatibilities between current images selected for calibration 
and the calibration file. Depending on the degree of divergence, click Finish or perform a new 
selection. 

 

When data is extracted from the EXIF metadata, the focal length [px] may not be 
identified during the process. Manually fill in the sensor width if it is not there. The sensor width 
data can be retrieved from the camera maker or any professional camera web site. 

 

If parameters are missing or there is a conflict with the EXIF data, you will be 
requested to select the “Custom” option to edit various fields. 

 

 Click Finish and the “Calibration Name” window (Figure 26) will allow you to confirm or 
modify the automatically generated name of your new calibration and optionally 
uncheck/check the checkbox to add it to the Calibration Library. 

 

Figure 26: Calibration Name Window 

The new calibration will automatically be selected in the “Choose Calibration” dialog box 
(Figure 27). 
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Figure 27: Choose Calibration Dialog Box 

 Click Link to link the images. Once the link process is done, the link result is displayed in 
the right panel (Figure 28). If the image set is selected carefully and according to the best 
practices, only one cluster will be generated. 

 

Figure 28: Link Result Window 

 Click “Next”, or alternatively click on the “Geo-Ref/Scale” tab, to move to the Geo-Ref/Scale 
stage. 

If more than one cluster is generated, select only one of the clusters in order to 
continue the calibration process. The final goal in this stage is to add floating control points that 
will generate an adjusted calibration which will be saved (exported) and used. 

 Select the cluster you want to work with if more than one exists. 

 Use any of the available model options, Geo-Ref, Scale or Rough Scale, as long as you have 
enough information to satisfy the minimal requirements. For example, keep the cluster 
model as a Rough Scale model, and add one Rough Scale and gravity to satisfy the minimal 
requirements of a Rough Scale model. Refer to Section 6.4.3 for details. 

It is preferable to work in Geo-Ref or Scale mode, but if you use the Rough Scale 
mode, make sure the distance you use is reasonably close to reality. The Geo-Tag option is 
superior to the Rough Scale mode when geo-tagging information is available on the images. 
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 Add additional floating control points to better relate images to each other. Refer to 
Section 6.4.10 on how to add FCPs. The more FCPs you add the better your calibration will 
be. 

 Click the Apply button, review residuals, and make adjustments following the standard 
work process untill you are satisfied with the results. (). 

 

 Select the menu option “Tools/Export Camera Parameters” (Figure 29). This will open a 
window that will allow you to select the cluster of which the adjusted calibration will be 
exported. Exported calibration can be imported into the calibration library at any time 
using the import function in the “Calibration Library” window. 

 

 

Figure 29: Exporting Adjusted Camera Calibration 

5.2 Field Calibration Image Set 
This section describes the best practices for taking or selecting images to perform camera field 
calibration. 

 Refer to Section 4.2 on the best practice for taking images for jobs where illustrations are 
also available. 

 DO NOT use images with sky, water or flat sand lacking features. 

 DO NOT use images with a lot of glass showing reflections. 

 DO NOT use images with moving objects in them, such as traffic. 

5.2.1  For UAV Cameras: 

 Take between 30 and45 images in a circular mode with equal intervals between them, and 
from distances of about 15-20 meters. 

 All images should be directed to a center point with a minimum 70% overlap between them. 

 Take oblique image at 45 degrees. 

 Images should have low frequency texture such as a stock pile, a rock, or an intersection. 
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5.2.2  For Ground Cameras: 

 Take between 12 and18 images following an arc with equal spacing between them, taken 
from distances of about 15-20 meters. 

 Do not use images that were taken in a straight line. 

 All images should be directed to a center point, with a minimum 70% overlap between 
them. 

 Images should have low frequency texture. 

5.3 Calibration Library 
 Click Tools > Calibration Library… in the main menu of DatuSiteTM. 

 Click Add, Edit, Delete, Import or Export to modify camera calibration files. 

o Add allows manually adding a new camera calibration file to the Calibration 
Library. 

o Edit permits modifying the calibration parameters to incorporate external 
parameters or to change the MSE. 

o Delete permits removing a specific camera calibration from the Calibration Library. 

o Import permits importing a camera calibration file into the Calibration Library. 

o Export permits exporting the selected camera calibration file. 

 

Figure 30: Camera Calibration Library 
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As part of the installation process, predefined camera calibration parameters are 
available for specific cameras. The internal calibration parameters vary for each camera. If the 
job results are not suitable when using pre-calibrated parameters, you may have to calibrate 
your own camera.  
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6 Working with DatuSiteTM 

6.1 Starting DatuSite™ Application 
The DatuSite™ application includes a series of opening screens which provide essential 
information about basic requirements and getting started. 

 If you do not want these pages to be displayed the next time the application is opened, 
unclick the “Show this at startup” checkbox. 

 

 

Figure 31: A Few of the Startup Windows 
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Figure 32: Welcome Screen 

6.2 Working with Jobs 

6.2.1  Opening a New Job 

To begin working with DatuSite™ – with photographs and measurements of a new area – open 
a new job. 

 At any stage in working with DatuSite™ you can undo (Ctrl+Z) and redo (Ctrl+Y) most 
of the steps performed. 

Once you have progressed to the next image or stage in the project, your work cannot be 
undone. Undo/Redo activities are per viewed-image or screen. It you move to another image, 
all actions which were “remembered” for Undo/Redo are lost. 

 Click File > New Job in the main menu of DatuSiteTM, or use the shortcut Ctrl+N. 

 Fill in the Job Name in the “Job Properties” dialog box. Use a standard naming convention 
that includes information such as the façade address, date of photograph, camera model 
and lens focal length, e.g.: CityName_StreetName_Date_Canon600D_24mm. 

 Select the method of image taking. When vertical is selected, and images have geo-tagging 
information, the link process will use the GPS position of the images to decide which images 
should be matched together. This means that images do not need to be ordered in a certain 
way for the link process to work.  

 Click OK. 
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Figure 33: New Job Dialog Box 

6.2.2  Opening an Existing Job 

To open an existing job: 

 Click File > Open Job in the main menu of DatuSite™ or use the shortcut Ctrl+O. 

 Browse to the DatuSite™ Jobs folder, click the Jobs folder, select the Job file, and click Open. 
The images are displayed in the “Images” window (Figure 35). 

 

 

Figure 34: Opening a Job 

 If not previously selected in the “Choose Calibration” box, select the appropriate camera 
calibration from the list of calibrated cameras. When possible the system will automatically 
select a suitable calibration based on the camera and lens model, and a notification will 
appear below the “Choose Calibration” drop down. 
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 Starting with DatuSite™ version 4.7.0 an improved camera calibration has been 
employed to generate a better model. Opening a job that was saved using a version prior to 
5.0.0 requires the user to go into the calibration library and select a new camera calibration. 

 Optional: Click New Calibration… in order to create a new camera calibration (refer to 
Chapter 5). 

 Optional: Click Tools > Calibration Library… in the main menu, in order to import a new 
camera calibration to the list (refer to Chapter 5). 

 If needed, click on Link to link the images. This may be required if you change the camera 
calibration or if the job was created using certain prior versions of DatuSiteTM. This step also 
may result in the clustering images into groups that may need to be manually linked 
together. This topic is covered later in this chapter. 

 Click Next. The “Geo-Ref/Scale” window is displayed. After clicking OK, the “Images” 
window is displayed and performing job’s tasks can be initiated. 

6.3 Step 1: Images – Loading Images, Camera Calibration, 
Linking Images and Managing of Clusters 

There are three main steps to complete in order to handle a job from start to end. This section 
describes the first step followed by steps 2 and 3. 

The first screen displayed after a job is opened is the “Images” window (Figure 35). In this 
window you handle the imagery of the job: loading images, removing images, calibrating the 
camera with which the images were taken, and geometrical linkage of the images. 

 

 

Figure 35: Load Images Window 
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 Click Load Images, and in the “Choose Images” window browse to the folder in which the 
image files are stored.  

 Select the relevant image and click Open. The system starts a process which includes part 
or all of the following: 

o Sanity check – Checking for EXIF data issues, such as resolution and date mismatch. 
Sanity check takes some time. It should be performed only when images are loaded 
and not when a saved job is opened. 

o Loading images – Copying images into job folder. 

o Image Preparation – Preparing all different images for job. 

o Blurriness check – Checking if any of the images have blurry areas (This is an 
optional step which may be turned on or  off in the Advanced Settings tab under 
the Tools/Setting menu option) 

The selected images are then displayed in the “Images” window.  

 

 

Figure 36: Images Window 

Both the Sanity check and the Blurriness check may result in issues that require 
resolution. Such issues are indicated by a warning sign on the image and also by a digit(s) 
showing the number of images with warning/issues (on the bottom left side of the Images 
screen). These issues can be resolved by right clicking on each screen and selecting the 
resolution action. 
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 Once images are loaded, click the “Map View” option “  “ shown at the top left corner 
of the window to view the locations of the images layered on top of a map as shown in Figure 
37. If an internet connection is not available, the background of the display will be black. 

 

Figure 37: Map View of Geo Tagged Images 

 Click on any image to open it in a new window. 

 Right click on any image to show additional options-- to delete one image or select images 
one at a time and then delete all selected images. Alternatively multi-select several images 
using a standard mouse function. 

 Images initially have a white marker, but after the link process is complete, each 
cluster will have its own color.  When selected, they will have a yellow marker. 

 

 

 Choose Calibration: If not automatically selected, select the appropriate camera 
calibration from the list of pre-calibrated cameras. If the camera in which images where 
taken, does not exist in the list, then the camera must be calibrated. Click New Calibration… 
in order to create a new camera calibration or click Tools > New Calibration … in the main 
menu (Refer to Chapter 5). 
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 Select Auto Generate Dense PC - This option will be available in the DatuSite Enterprise.  
Check it if you would like the system to generate a dense point cloud at the end of the linkage 
process. The point cloud generated using the option will be using the Dense level option. 

 

 Click Link. The images are automatically linked in clusters (groups of linked images) based 
on homological points. 

If your images have GPS data the link process will be based on the GPS location of the 
images, hence there is no need to order images in the “Images” tab. If no GPS data exists on 
the images, then the link process will be based on the order of images in the “Images” tab. 

6.3.1  Short Baseline Issues 

If the link process detects consecutive images with short baseline issues (images that are very 
similar), then the system will indicate this fact on the right side of the screen and will 
automatically open a window to allow the resolution of this issue by deleting some of the 
images. If you select not to resolve some or all of the issues, the message will remain on the 
screen with an option to click Resolve…” to go back and rectify the situation. As shown in Figure 
38 the images are grouped and, by default, all are marked for deletion except for the first one 
in each group. Once you click OK, marked images will be deleted and images will have to be 
linked again. 

 

 

Figure 38: Resolving Short Baseline Issues 

6.3.2  Manually Linking Image Clusters 

If the angles of photographing are extreme, images cannot be automatically linked into a single 
cluster and several unlinked clusters are created. Each image is marked in its bottom left corner 
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as to which cluster it belongs to. The list of clusters is shown on the bottom right side of the 
screen. The list initially shows only main clusters in cases where the number of images in these 
clusters is greater than 20% of the images linked. Use the “Show all clusters” link to show the 
rest of the clusters in the list. Only clusters with three images or more will be shown. This is 
also true in any window where a cluster list is shown. 

 

Figure 39: Multiple Image Clusters 

You may select to ignore the fact that you have multiple clusters and continue your work dealing 
with several clusters in the jobs, which can be handled separately throughout the job as sub-
jobs. Otherwise, you have the option to attempt to connect the clusters by adding tie points. 

 Manually connecting image clusters is a feature available as an advanced function. If 
it is not available, and you do wish to use it, use the menu option “Tools/Settings” and activate 
it in the “Advanced” tab. 

 To connect image clusters, click the Cluster Connector button which opens the window 
shown in Figure 40. 
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Figure 40: Cluster Connector 

 Add sets of six or more tie points between each two clusters that appear to be linkable.  

These sets of tie points are called connectors. It is possible to add one or more 
connectors between any two adjacent clusters, but each one of the connectors needs to have a 
minimum of six tie points. 

 

If all images were initially linked into one cluster, no merging is necessary and the 
Cluster Connector button is not displayed. 

If a large number of clusters include one particular image, change the order of the images so 
that they reflect their actual appearance in the field where they were taken. 

: 

 To add cluster connectors, click Add below the connector list. 
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Figure 41: Adding a Cluster Connector 

 Select two clusters from the drop down list and click OK. This will automatically select the 
last two images of the first cluster and the first two images of the second cluster (Figure 
41). 

 

Figure 42: Adding Manual Tie Points for a Cluster Connector 

 Click Add in order to add at least six tie points on all shown images (located below the 
manual tie point list). 

 Left click to mark the tie points on all the images. 

 Zoom images as needed to identify and mark points. Once the third tie point is marked on 
all images residual values will appear indicating how good your markings are. 

 When sufficient tie points have been identified, click OK and link images again. 

 Once you are happy with the link process and cluster result, then you can move forward to 
Step 2 = Geo-Ref/Scale. 

Upon loading the images, DatuSite™ automatically calculates the relative orientation 
of the images by finding homological tie points through state-of-the-art image processing 
algorithms. 

6.3.3  Viewing Clusters in 3D 

After a successful link is completed, the “3D View” option “  “ at the top left corner 
becomes available to show the Point Cloud in a 3D viewer (refer to Figure 43).  If a dense point 
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cloud was automaticlly generated after the link, this viewer will show the dense point cloud, 
otherwise it will show the sparse point cloud generated by the link process. 

 

Figure 43: Sparse Point Cloud Display 

6.4 Step 2: Geo-Ref / Scale 

You have the option of selecting one of four working modes for each one of the clusters (refer 
to Figure 44). 

 

 

Figure 44: Model Referencing Modes 

For Geo-Ref and Scale clusters you may define as many control points and as many scaling 
distances as you want. For Rough Scale clusters you will be able to define only one approximate 
distance. For Geo-Tag mode you do not need to define anything. The system will set the project 
orientation and the scaling based on the image geo tags. Adding GCPs and your scaling distances 
will be described later in this section. 

While working with any of the four modes it is possible to add floating control points (FCPs) to 
strengthen the coherence between images. This improves the accuracy of all functions, 
especially when the project includes a large number of images. FCPs are basically control points 
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without coordinates. So you may define any clear feature in two or more images and it becomes 
a control point, and you may define as many control points as you want.  

 To add an FCP under any mode, use the ( ) tool bar button and click anywhere on the 
image to add a new FCP or mark an existing FCP. Refer to Section 6.4.5 detailed instructions. 

The following sections provide directives in regard to how to work with the different modes. 

6.4.1  Working in the Geo-Ref/Scale Stage 

The “Geo-Ref/Scale” tab sets the basis of how accurate the model will be. Regardless of which 
mode you are in, if you start correctly in this stage, then everything will be accurate throughout 
the whole project. This is particularly important when you work in the Geo-Ref or Scale mode 
as this will set the geo referencing or scaling. When working in Rough Scale or Geo-Tag modes, 
it is assumed that accuracy is not as important at this stage, but it could be later if you decide to 
switch the job back to either Geo-Ref or Scale mode. 

For each mode there are some minimal definition requirements the system needs in order to 
be able to refine the camera position and orientation parameters so they will minimize 
projection errors. This refinement calculation is referred to as “Bundle Adjustment”. The 
Bundle Adjustment calculation can be re-done at any time to improve the refinement of the 
parameters, and can also be based on different points including GCPs, FCPs, new points (not 
including topo points), and distance end points. The more points you use the better the 
refinement, but it takes more time. These minimal requirements are mentioned in other places 
in this document, but for convenience, they are provided here again: 

 Geo-Ref minimal requirements – A minimum of three ground control points marked 
in two images covering a span of about 90 degrees. Meaning that you should mark each 
control point on at least two images where the angle between the first and the last image 
is close to 90 degrees. However, it is strongly recommended to mark 4 GCPs and 
mark each one in at least three images. 

 Scale minimal requirements – A minimum of two distances marked in two images 
with the gravity direction set. The two images should cover a span of about 90 degrees 
as explained in the Geo-Ref minimal requirements. 

 Rough Scale minimal requirements – Only one distance marked in two images with 
the gravity direction set. The two images should cover a span of about 90 degrees as 
explained in Geo-Ref minimal requirements. 

 Geo-Tag minimal requirements – No marking is required. The system will use the 
image location in the EXIF data which is the basis for orientation and scale. 

Once the minimal definition requirements are met for the selected image cluster, the system 
will calculate the refined parameters.  

 Click Apply. The Running Bundle Adjustment calculation is activated. 
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Figure 45: Clicking the Apply Button to Activate the Running Bundle Adjustment Process 

As shown below, the Apply button has two modes; Fast and Fine. The Fine mode uses a large 
number of tie points to perform the refinement, hence it is more accurate. The Fast mode, on 
the other hand, uses a subset of tie points, so it takes a very short time to give you some 
preliminary results of residuals. 

 Click Apply (Fine) the first time you satisfy the minimal criteria. 

 Click Apply (Fast) when adding new points. 

 Prior to proceeding to the next stage, click Apply (Fine) again to build a precise model. 

 

Figure 46: Selecting Fast or Fine Mode 

Each time Apply is clicked, the system performs a full refinement calculation (Sparse Bar 
Adjustment – SBA). This provides marking accuracy residuals for GCPs FCPs and distances 
depending on the mode in which you are working. Once this refinement is done, you can add, 
adjust, or delete points or distances. When this is done, the system gives a message that the 
model has changed and you need to click Apply. It immediately updates the marking residuals 
for the point that was changed using a quick transformation calculation. Therefore it is not 
necessary to click Apply after every change. 

Once you have completed your Geo-Ref, Scale, or Rough Scale and point adjustments, click 
Apply again. This will recalculate the referencing allowing you to go to the “View & Export” 
function. Finally, when you finish all your markings, you click Apply. During this process, the 
system will re-calculate the coordinates of all the new points including topo points, and it will 
display the progress bar (Figure 47). Once done, it will move to the selected tab. 

 

Figure 47: Calculating New Point Coordinates 
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The following are general recommendations for adding control points or distances for each 
cluster of a new project. 

6.4.1.1 Geo-Ref Clusters 

 Satisfy the minimal requirements. Add a minimum of three ground control points (strongly 
recommend 4 GCPs) on at least two different images (strongly recommend four GCPs on at 
least three images each) as distant as possible from the edges of the images. When marking 
ground control points, select images with about 90 degrees between the first and last one. 
Make sure the ground control points appear around the outside of the area or interest. This 
ensures that the values will be interpolated and not extrapolated. 

 In large-scale projects photographed vertically, especially long roads, you should mark 
enough control points to cover the whole project. For example, mark control points in the 
beginning, middle, and end of the road. 

 Click Apply. If the residuals are not satisfactory, go back and check your markings and 
adjust where needed. Click Apply again until you have good residuals, i.e. all residuals are 
green. 

 Turn on projections. 

 Start checking images that are distant from the original images (where you marked the 
GCPs) and determine if the projections are where they should be. If needed add more 
ground control points and/or floating control points to improve the projections. Be certain 
that every control point is added to at least three images. 

 Once finished. Click Apply again. 

 Repeat steps 4 and 5 until you are satisfied with the projections. 

 You may then move on to the “View & Export” function. 

6.4.1.2 Scale Clusters 

 Satisfy the minimal requirements. Add distances and set the gravity. When adding the first 
set of distances, select two images that are about 90 degrees relative to each other. Make 
sure the distances appear in both of them. Try to use distances that are not very short in 
relation to the area of interest. 

 Click Apply. If residuals are not satisfactory, go back and check your markings and adjust 
where needed. Click Apply again until you have good residuals. 

 Add more distances and/or floating control points to strengthen the ties between the 
images. Make sure you distribute the new distances and floating control points throughout 
the entire cluster. 

 Click Apply again and check residuals. 

 Repeat steps 3 and 4 as required. 

 You may now move to the “View & Export” function. 

6.4.1.3 Projections of GCPs, FCPs and Distances 

The projections of Control Points as well as Distance end points can be shown on other images. 
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 Click Apply on images in the same cluster. A model is built and then projections are shown.. 

 To turn projections on simply check the “Projections” check box in the upper right corner 
of the Geo-Ref/Scale screen (Figure 48). 

 

Figure 48: Projections Check Box 

 To select what will be projected click the Projections… Check Box (Figure 48). This will 
open the “Projections Settings” window Figure 49 which will allow you to make your 
selection. The Projection Settings here are global and not for a specific cluster. Thus, they 
can be set and saved for a job regardless if there are control points or distances in the job. 
Projections of floating control points and distances projections will be made in the cluster 
they are marked in, while ground control points projections will be marked in images in any 
Geo-Ref’d cluster if possible. 

 

Figure 49: Projection Settings 

The Custom… link allows you to select a subset of ground control points to be projected. 
The “Projection List” selection window is shown in Figure 50. 
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Figure 50: Projection List Window 

General Guidelines 

 GCPs are projected only in Geo-Ref’d clusters.  

 FCPs are projected in all cluster types only in the Geo-Ref/Scale stage. 

 Distance Points are projected only in Scale and Rough Scale clusters only in the Geo-
Ref/Scale stage. 

6.4.1.4 Show Names 

In the Projections Check Box, check or uncheck the “Names” checkbox to show or hide 
the point and projection names on the images. 

6.4.2  Working in Geo-Tag Mode 

Working in Geo-Tag mode means that the model will be built with the following characteristics: 

 Anchored: The anchoring will be based on the image geo-tagging information available in 
the EXIF data of the images. You are not required to set gravity or scale. 

 Roughly scaled: Meaning that it will have approximate dimensions. The model will be built 
based on geo-tagging information. 

6.4.3  Working in Rough Scale Mode 

Working in Rough Scale mode means that the model will be built with the following 
characteristics: 

 Floating: It is not anchored to the ground and does not have a perfect orientation. You are 
required to set the gravity direction so the model will be vertically correct, but it will not have 
the correct azimuth (angle from north). 
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 Roughly scaled: It will have approximate dimensions. The model will be built based on the 
specified Rough Scale but it will have the right aspect ratios. 

This mode is useful for the following purposes: 

 To build a model for a presentation to show the concept or advancement in building 
processes or excavations or filling processes without the need to have control point 
measurements. 

 Images exist from a particular job, but ground control points or distances have not yet been 
measured. In this case it is possible to start all the drawing processes and when the survey area 
is measured, ground control points or distances can be added, and the work can be completed. 

To work in Rough Scale mode, simply select Rough Scale for a specific cluster, follow the 
instructions to define one rough distance and define the gravity similar to what is described in 
“Working in Scale Mode” (Section 6.4.4 ). 

Click Apply, and go to “View & Export” function. Rough Scale names will start with the letter “R” 
indicating the measurement was roughly estimated. 

6.4.4  Working in Scale Mode 

Working in Scale mode allows adding a measurement reference to the job. This facilitates taking 
accurate measurements between new points, as well as building scale sized models. All this can 
be done without any special surveying tools. Scale mode is ideal for stock pile volume 
calculations, since volume calculations do not require geodetic positions or orientation. 

Scale is easy and can be done by measuring as few as two distances in the field, then marking 
these measurements on at least two images. When distances are added, the Distance Marking 
Accuracy measured will provide residuals for both the distances and for end points. This will 
be shown in the right pane of the application similar to the “Control Point Marking Accuracy” 
table. 

To add a distance while working in Scale mode follow the steps below: 

 Select the distance marking tool  from the tool bar. A distance marker with the number 
1 is attached to the mouse pointer. 

 Mouse over to the first termination of the distance you wish to mark, and click it. Zoom in 
as needed to mark the right point.  

 You are prompted to determine if this is a new or existing distance you are adding. If this is 
a distance you have previously marked on other images, click Existing (Figure 51). If this is 
a new distance, enter the measured distance in the field that is displayed (Figure 52). 
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Figure 51: New or Existing Distance 

  

Figure 52: Setting the Measured Distance 

 If you picked an existing distance, select one of the available distances from the drop down 
option (Figure 53). 

 

Figure 53: Selecting an Available Distance 

 Click OK, and a distance marker with the number 2 is attached to the mouse pointer. 

 Mouse over to the other end of the distance marked, and click on it. Zoom in as needed to 
mark the right point. 

 Repeat these steps to add more distances as needed. All distances will appear in the 
Distances list as shown below in Figure 54. 
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Figure 54: Scaling Distances 

 Define the model gravity, by clicking on Define Gravity. If images have GPS data the system 
will try to automatically define the gravity vector based on GPS data. If it succeeds to do so, 
it will display a message below the Define Gravity button saying that Gravity was defined 
automatically. Otherwise, a dialog (Figure 55) will be opened to allow the user to manually 
define the gravity vector. 

 

Figure 55: Defining Gravity Dialog 

There are two ways to define gravity direction. One is by a vertical line in one of the 
images. If no vertical line exists, a horizontal plane can be defined. Both definitions use existing 
points including GCPs, FCPs or distance end points. If you do not have suitable points, you will 
need to add FCPs for this purpose.  
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 Make your selection and click OK. The mouse cursor turns to this icon . 

 Select points as instructed. Each point you select will be marked clearly with an icon like 

this . Additionally all points that are participating in the gravity setting will be clearly 
marked with the letter G in the list of points or distances on the top left part of the Geo-Ref 
screen.  

The software will do its best to detect the direction of the gravity based on the images, 
but you will always have the option to reverse the software’s detection with a click of a mouse 
on Flip Gravity in the 3D Model screen under the “View & Export” tab. 

 Once you satisfy all of the requirements of distances and gravity, click Apply and then move 
on to the “View & Export” function to continue your work. 

6.4.5  Working in Geo-Ref Mode 

Control points are the measurement points taken in the field using traditional geodetic 
measurement equipment, such as a robotic total station or RTK GPS. With DatuSiteTM, there is 
no need to collect dozens of measured points in the field as is done conventionally. You only 
have to measure a few, well identified points that are uniformly spread over the job’s area. Each 
control point should be a measurement of an object existing on at least two images. The number 
of required control points is a factor of the complexity of the site but new control points can 
easily be added as you move forward so there is no need to overpopulate an image. 

6.4.6  Importing Control Points 

The control point measurement file, containing the project’s control points, should be imported 
at this stage. 

 Click Import and select the measurement file. The “Import Measurement” window is 
populated by the control-points data measured in the field. It is recommended to have a 
text file (.txt, .pnt, or .csv) of your field measured control points. 
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Figure 56: Selecting the Control Points File 

 

Figure 57: Import Measurements Window – View of TP (Control Points) File, Prior to Import 

 The “Import Measurements” window (Figure 57) shows how DatuSite™ parses the control-
points file. If the parsing is not correct, you can set the correct delimiter, change (by 
dragging) the order of the coordinate columns, and set the decimal separator. The default 
measurement unit is in meters but you can change it by selecting other units from the 
dropdown list. 
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o The “<file_name> content preview” field shows the original text as it exists in the 
file. 

o The “<file_name> filtered preview” field shows the interpretation of the file in which 
the contents have been parsed to Name, N, E, H (coordinate values), Code name, 
Description, and Point Comment. 

 To save the formatted parameters, click New and provide a Format name for the New 
Format (Figure 58). 

 

Figure 58: Saving Import Measured Points, Format Interpretation 

 To delete a format setting item from the “Format Settings” list, select the item from the 
dropdown list and click Delete. 

 To save a format settings item in the “Format Settings” list, click Save. 

 If point attributes within the TP file are ordered differently from the default order, columns 
can be dragged and reordered. 

 Use the Start Import at Row, Delimiter, Units of Coordinates and Decimal Separator, to 
modify the formatted imported parameters. 

 Click Import. DatuSite™ checks the control points to verify that a point with the same name 
does not already exist in the job. If it does, the application prompts the user with a dialog 
box to skip, rename or overwrite the existing point. 
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During the import process, a control point with a code that already exists in the job’s 
codes library receives that particular code. Other control points remain without codes. 

6.4.7  Marking Control Points 

Images are anchored by control points. Reference points, before being anchored, are called 
projections. Projections as well as marking residuals are shown after meeting the minimum 
marking requirements. Figure 59 shows the basic “Geo-Ref/Scale” window followed by an 
explanation of its components. 

 

Figure 59: “Geo-Ref/Scale” Window 

6.4.7.1 Left Pane 

Control Points – This is a list of all imported or manually added ground control points and 
floating control points. If the control point is marked on at least one image, an anchor icon is 

shown to the left of the control point name. The icons are different for GCPs  and FCPs 
both on images as well as on the table on the top left. In (Figure 59) four control points are 
marked on at least one image. 

Images below control points list –All the images in which the selected control point appears 
are shown with the control points marked.  Additionally, a hint of where the selected ground 
control point may be in other images.  Hints are given based on Epipolar line calculation and 
will start appearing as an Epipolar circle hint after the model is built by pressing the Apply 
button the first time. User then may scroll down and select the image they wish to mark the GCP 
in.  The hint will also appear in the main image display as shown in the figure below. 
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Figure 60 - GCP Hints on Image Thumbnails and Main Image 

6.4.7.2 Right Pane 

Show Names and Projection – These check boxes enable and disable showing the names of 
the control points and the projections as well as showing the projections themselves. 

Click Projections… to select the points that you would like to see projections for. 
Projections are shown after meeting the minimum marking requirements. 

Clusters – a list of image clusters built by the link process with the option to select the 
referencing mode for each cluster. 

Select a cluster from the list to show the thumbnail images of the selected cluster as well as 
one of the cluster images on the center display. 

GCP Residuals [m] –The system shows the point with the highest residual in the actual 
measurement unit (meters, feet, etc.).  

Click Details… to show all marked points residuals without having to go to the “View & 
Export” screen. 

Control Points Marking Accuracy – Residuals of all markings are shown here. Values are 
automatically shown after meeting the minimum marking requirements, and are updated every 
time a point is added, deleted, or moved. Colors of residuals indicate their quality. Ranges for 
each color may be set in the “Tools/Settings” option in the “Accuracy Display” tab. 

6.4.7.3 Bottom Thumbnail Banner: 

Thumbnails of all selected cluster images are shown here.  

Click or drag an image to the main image display to work with it. 
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On each thumbnail there are two indicators (Figure 61). In the upper left corner the number 
of control points is marked, and in the upper right corner the color of the overall tie point 
detection accuracy on this image is indicated. 

 

Figure 61: Thumbnail Banner 

On the upper right corner of the banner click one of the following options: 

o Map View… If images are geo-referenced, the map view is available. It also allows 
you to select the image that will be displayed in in the “Geo-Ref/Scale” tab for 
processing and adding control points. 

o Show All. Show images of all clusters. 

o . Opens an expanded view of images. 

6.4.7.4 Main Image Display: 

The Main Display is where all work is done as far as marking and editing the control points. 
Figure 62 displays an image with all of the different options including projections. 

 

Figure 62: Marked Image 
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  To view information about one or more control points, click the Indicator icon ( ) and, 
mouse over the desired control point. The control point will be highlighted and if Names 
was not previously checked, the name of the highlighted point will be displayed. 

 Right-click a control point to display a context menu. This permits performing several 
actions on the point, including displaying the Properties of the point. The same context-
menu appears if you right-click on a control point on the “Control-Points” list in the 
window’s left pane. 

6.4.8  Anchoring Control Points 

To anchor a previously defined ground or floating control point on images: 

 Select a cluster (group of linked images). 

 Select an image from the selected cluster by clicking on images or dragging to the viewer 
from the thumbnail banner images from images in the left pane. 

 Click the Point Selection icon ( ). A crossbar cursor appears over the image. 

To zoom in on a particular area of an image, use the scroll wheel on the mouse to adjust 
the size of the image. 

 

To scroll through an image, right click and hold the mouse right button and drag the 
image in any direction. 

 

 Zoom into the area of where you want to mark the control point, put the cursor on the right 
position and left click to mark it. The “Mark Control Point” dropdown box is displayed. 

Note that the projection marker is used to assist in finding the vicinity of the point. Put 
your mark on where the point was originally measured in the image and not on the projection 
marker itself. 

 

 Click on the arrow in the “Name” dropdown box (Figure 63) and select the relevant control 
point based on its name and the field sketch (or image) detailing the control points 
measured in the field. 
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 Click OK. 

 

Figure 63: Marking Control Points 

 Repeat this process until you have marked at least three ground control points and as many 
floating control points on at least two images. It is recommended that you distribute the 
points to identify the width, length, and height of the project. 

Revising the position or coordinates of a control point will change the geo-referencing 
of the photogrammetric model, and will change the coordinates of any new point measured on 
the images. 

 To edit ground control point properties, click the Indicator icon then right click on the 
control point, on the image, or in the list of control points to provide a list of operational 
functions related to each control point. 
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Figure 64: Control-Point Context Menu 

o Click Select in Viewer to highlight the selected point and display its name. 

o Click Rename to rename a point without changing its coordinates. 

o Click Replace with to replace the point’s name and coordinates with one of the 
points in the TP measurement file. 

o Click Delete to remove a point from the list. Several options are provided: 

 Delete point from entire job. 

 Delete mark from this image only. 

 Delete mark from all images. 

o Click Properties to manually edit the point coordinates (Figure 49). 

 

 

Figure 65: Editing Control-Point Dialog Box 
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 Subsequent to the creation of each new control point after meeting the minimum 
requirements, the application will recalculate and display the residuals. If residuals become 
faulty after adding a point, recheck the position of that point in all images in which it is 
marked. 

 Click on any of the points shown in the “Control-Points” list (left pane) to display all images 
that contain that particular point. Thumbnails of the images are shown below the “Control-
Points” list. 

 Click on a thumbnail in the “Control-Points” list (left pane) to display that image in the main 
window. 

To locate a particular control point, use the “Search” window located at the top of the 
“Control-Points” list. 

6.4.9  Adding a New Ground Control Point 

If a control point is deleted, all its projections will be removed. Similarly, If a control point is 
restored (using the undo function), all its projections will be restored. 

If an important projection is missing in the TP measurement file, a new control point can be 
created. The relevant information with the required parameters should be provided by a 
surveyor who worked in the field. 

 To manually add a new control point click the “+” button below the “Control-Points” list. 

 In the “New Control Point” window, fill in the coordinates and other related information. 
Provide a code (if available) and description and click OK. The Code is only relevant when 
provided for a measured point by the TPS. 

 

 

Figure 66: New Control-Point Dialog Box 
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6.4.10  Adding a New Floating Control Point 

 To add a new floating control point, Click the Point Selection icon ( ). A crossbar cursor 
appears over the image. 

 Click on the location on the image where you want to add the new floating control point 
(Figure 67). 

 

Figure 67: Adding a New Floating Control Point 

 Click on the New FCP button, and it will add a floating control point named FCP_x, where x 
is a sequential number assigned by the system. Once you add a new point on one image you 
can anchor it on other images following the same method as adding a pre-defined ground 
control point. 

6.4.11  The Geo-Referencing/Scaling Marking Accuracy Indicator 

Marking accuracy calculation should be performed in the following instances: 

 After marking at least three control points on two images in the survey area. 

 Whenever any of the existing control points (GCP or FCP) are edited. 

DatuSiteTM calculates the geo-referencing of the photogrammetric model based on ground 
control points, floating control points, and distances in the images. It compares the relative 
orientation of the images inferred from the geo-referencing to the relative orientation implied 
from the automatic image processing of tie points. Additionally, the user may also include or 
exclude all points mentioned above as well as new points drawn on the images in the calculation 
by setting the SBA (Sparse Bundle Adjustment) options in the SBA tab of the settings window. 

The color of the Marking Accuracy Indicator (green, yellow or red) indicates the accuracy of the 
photogrammetric model. A green light indicates the accuracy is good. A yellow light indicates 
that accuracy of the photogrammetric model is fair, and a red light indicates that accuracy of 
the photogrammetric model is poor. 

 To recalculate the photogrammetric model, click Apply button at any time. 

 Check and edit the exact anchoring of any control point that has large residuals, as indicated 
by yellow or red marking, by comparing it to the field sketch. 
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 Repeat this procedure until the Marking Accuracy Indicator is green, or when you are 
satisfied the marking accuracy meets your minimum requirements. 

6.4.12  Marking Accuracy List 

Marking accuracy determines the difference between the marked position and the calculated 
or predicted position of any point. All residuals are important because they show how accurate 
the marking is. The residual is determined by taking the predicted value and comparing it to 
the marked value. 

Image marking accuracy residuals are always measured in pixels so that their absolute value in 
centimeters or inches is relative to camera resolution and the distance between the camera and 
the object. 

DatuSite™ is pre-configured so that measurement errors smaller than three pixels are colored 
in green, measurement errors of three to four pixels are colored in yellow, and measurement 
errors larger than four pixels are colored in red. These parameters are configurable by the user 
in the “Settings” window (refer to Section 7.2.1 ). 

1 Check and edit the exact anchoring of any control point that has large residuals, as 
indicated by yellow or red markings, by comparing it to the field sketch, and recalculate 
the geo-referencing of the photogrammetric model. 

2 Click on any point in the residual list in order to view thumbnails, under the “Control-
Points” list (left pane) of all images containing that particular point. 

6.4.13  Export Camera Calibration 

In the event that the job results are suitable you can use this particular job for future internal 
camera calibration. Suitable results are indicated by the existence of a single cluster with the 
Geo-Referencing Quality Indicator being acceptable (green). 

 In the Tools menu, select Export Camera Parameters. 

 In the Tools menu, select Calibration Library… option and Import this new Calibration file 
by clicking on the Import button and selecting the file recently saved. 

6.5 Step 3: View & Export – Previewing and Exporting to 
Exchangeable Formats 

In the “View & Export” window you can view all surveying map data created by Datumate 
software such as DatuSurvey, and generate and export additional outputs such as volumes, 
dense point clouds, mesh and texture.  Each output can be generated in one more exchangeable 
formats.  In addition, you can manage the content of the export by selecting the desired 
exported layer, control points (used, all, or none) as well as selecting some viewing options. 
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Figure 68: View & Export Window showing objects created by DatuSurvery Ent. 

The “View & Export” functions are broken into 9 tabs that can be broken down into 3 groups 
as follows: 

1. “3D Model”, “Projection Preview”, and “Control Points”,– these tabs all relate to objects 
that were added by the user and may be exported as a 3D model to DXF format output. The 
right side panel of all of these tabs is the same and regardless of where you make a change 
or a selection, it will apply to all of the tabs.    Section 6.5.2 below describes in detail the 
different export options available.  

2. “Volume Calculation” - This tab handles all functions related to volume calculation.  
Section 6.5.3 below describes in detail all functions related to volume calculation.  

3. “Dense Point Cloud”, “Point Cloud Projection” and “OrthoPhoto” – these tabs all deal 
with functions related to dense point cloud; both generation and exportation.   

Some functions described above may also be available from other places in the software.  

6.5.1  View & Export Tabs 

The “View & Export” tabs provides views and information of the project from different 
perspectives, as well as providing different export options as follows: 

 3D Model: Displays a 3-dimensional view of the selected layers. This is applicable only if 
job was saved by other packages and opened using DatuSiteTM. The colors of the objects 
displayed in the 3D Model are in accordance with the colors of the layers as defined in the other 
package. This window has the following functionality: 

o Hovering over a point shows the point name. 
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o Showing point names checkbox which allows you to hide or display the names of all 
measurement points.  When a dense point cloud overlay is selected, the names will 
not be shown even if this option is checked. 

o Selecting the Dense Point Cloud view, if available, that will be overlaid on top of the 
3D model. This does not affect the export options at all.  The overlay options as 
shown are None, Point, Mesh, or Mesh and texture.   In the same line of the overlay 
selection it also allows to export the overlays to different formats as shown below. 

 

Figure 69 - Exporting Dense Point Cloud Options 

  

o Clicking and holding the mouse’s right button to pan over the view. 

o Using the mouse wheel to zoom in and out. 

o Clicking and holding the mouse’s left button to rotate the view. 

o Right click to get the option to reset the view based on available display space; Zoom 
Extent. 

 

 Projection Preview: Presents a top-down view of the entities-to-be-exported, reflecting 
the vector-projection which has been set. If no-projection has been selected, nothing is shown. 
This window also provides panning and zooming. 

 Control Points: Gives a list-view of all control points positions and residuals in meters. 

 Volume Calculation: Provides ability to calculate volume concealed in measured 
structures. Volume calculation is covered in detail in section 6.5.3  below. 
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 Volume calculation requires that either Geo-Ref or Scale cluster be selected. It will not 
work on a 3D model without any scaling property. 

 Dense Point Cloud: Available only in the Enterprise Package. It allows generation of a 
dense point cloud if not previously generated, and manipulation of the dense point cloud in a 
3D viewer. It also allows exporting the Dense Point Cloud to .PLY or .LASfiles (Figure 70).  

 

 

Figure 70: Dense Point Cloud 

Pressing the “Generate Dense Point Cloud” button will open a dialog to allow selecting what 
to generate.  Refer to section 7.2.4 for more details.   

Pressing the “Export” button will open a dialog to allow selecting what to export.  The dialog is 
shown in Figure 69 above. 

 Point Cloud Projection: Available only in the Enterprise package. It allows the projection 
of selected dense points from the 3D cloud on a 2D surface and saving it to.PLY file formats 
(Figure 71).  
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Figure 71: Point Cloud Projection 

 Adjust the boundaries of the area you would like to project by stretching the shown 
rectangles on the three views. 

 Rotate the cloud itself clockwise or counter-clockwise using the arrows available for 
that on the bottom right corner of the top view. 

 Once an area is selected click Project Point Cloud to show the top view projection. 

  Save or discard the projection. If you select to save it, you will be prompted to select 
one of more views out of the six sides of the cube to save, and all selected views will be 
saved in .PNG as well as the selected format in the selected folder.  In this version only 
.PLY format is available.  Other options will be added in the future.  

 Orthophoto: Available only in the Enterprise package. It allows the generation of an 
orthophoto of a cluster. The result will be saved in a tiled tiff format in a folder that has the 
name of the cluster. 

6.5.2  Exporting Job Data 

To export the measurements as final output files or as input to CAD software for further 
processing, in the right pane, perform the following steps: 

 Select the layers to be included in the export by using the checkboxes to the left of the layers’ 
names. 

 Select which layers to mesh, by using the checkboxes to the right of the layers’ names. 

 Select which control points to include in the export (none, just the used control points or all 
the control points). 

 Select the output file format: DXF, ENH, NEH or PDF. 

 Select the projection: 
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o No projection. 

o Horizontal plane – set the H value of the horizontal plane. Type a specific value or 
set the height by selecting a new point from the list so its height will set the 
horizontal plane of reference. 

o Vertical plane – sets a plane, perpendicular to the horizon, which passes through 
two selected new points. All measurements, then, undergo vector-projection. 

 Click Export. 

Management of data in the “View & Export” window does not alter the data stored by 
DatuSiteTM. Changes are made only for preview and export. 

6.5.3  Volume Calculations 

6.5.3.1 Background 

 

Figure 72: The Volume Calculation Window 

The “Volume Calculation” window (Figure 72) in the “View & Export” window is used to 
calculate volume of material enclosed within a relief structure. This is useful in construction 
works, earth works, tunneling and mining, where large quantities of soil have accumulated or 
are planned for excavation and measuring of such an aggregation is necessary. 

Volume calculation is done based on one surface or on two surfaces. In the first case, DatuSite™ 
creates a convex hull, a virtual surface enclosing the given physical surface, then, calculation of 
the volume enclosed between the physical surface and the convex hull is performed. In the 
second case, DatuSite™ calculates the volume of material enclosed between two given physical 
surfaces. 
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In the current version of DatuSiteTM, in order to calculate a volume, the base surface, if defined, 
must fully include the selected surface (Figure 73). 

 

Figure 73: Supported Surfaces Geometry 

 

Defining the physical surface (the stock pile) can be done right on the dense point cloud as 
described in section 6.5.3.2 below.  This feature is available only in DatuSiteTM Enterprise 
package only. 

6.5.3.2 Marking stock piles on dense point clouds  

Starting in version 5.1, using DatuSite Enterprise, it is possible to mark stock piles right on the 
dense point cloud.   To do so, perform the following steps: 

 Make sure a dense point cloud was generated for the selected cluster.  

 In View & Export, select the Volume Calculation tab.  The first time the tab is opened in a 
job, the window will look as show in the figure below.  
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Figure 74 - Volume Calculation Tab 

In the tool bar there are 3 tools as follows:  

 - This tool is for viewing a specific layer in 3D.  It will allow rotation of the layer to 
allow viewing from different angles. See figure below. 

 

Figure 75 - Viewing Mode in Volume Calculation 

 - This tool is for sketching topo surfaces right on the dense point cloud. When clicked 
it will show the dense point cloud in top view, and if the selected surface does include some 
objects they will also be shown.  See figure below. 
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Figure 76 - Topo Surface Mode in Volume Calculation 

 - This tool is for defining a base surface that can be used as a base surface for other 
topo surfaces for volume calculation. Such surfaces may be cloned or flattened if needed 
using the hot menu options available on the surfaces list before they are used as a base 
surface.  As in the topo surface marking tool, when selected it will show a top view of the 
dense point cloud and objects in the selected surface. 

 Select the topo surface marking tool (  ), which will show a top view of the dense point 
cloud.  You may also want to select a specific surface you would like to use as a basis for 
marking the new topo surface.   

 Mark the desired stock pile by drawing a polygon around it with single left mouse clicks, 
and close with a left mouse double click. 

 

Figure 77 - Marking a Stock Pile on Dense Point Cloud 
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 Once the polygon is closed a new 3D display showing the marked stock pile in top view, 
which you can rotate to view from different angles.   Here you may also change the stock 
pile smoothing level using the slider at the bottom of the display 

 

Figure 78 - Stock Pile Smoothing 

 Once you are satisfied with the smoothing level, press the “Apply” button to finalize the 
stock pile definition.  This will show the dialog below to allow you to put the stock pile in 
an existing or new surface.   Only Cloud surfaces may be used.  

 

Figure 79 - Adding a Surface 
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 Select the options you desire, set the color of the surface, and press OK.  You will then see 
the surface defined as topo points over the dense point cloud, and the surface used will be 
selected.   This surface will be marked as a cloud surface.  See figure below. 

 

Figure 80 - Defined Topo Surface 

 

6.5.3.3 Importing surfaces from external sources 

To import and external surface perform the following steps: 

 Click on Import surface from file… below the surface list. The “Import Surface from File”.  

 Browse to the required points XYZ file, parse the point lines as needed and click on Import. 
The “Import Surface from Point File” window closes and the “Add Surface” window opens. 

 Type a name and description for the new surface (by default the surface will get the file 
name) and set the surface color (by default the color will be as different as possible from 
the colors of the existing surfaces). 

 Click OK. The file’s points will be imported to the new Surface object. 
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Figure 81: Import Surface from Points File Window 

 

Figure 82: Add Surface Window 

  

6.5.3.4 Calculating Volume 

To calculate volumes perform the following steps: 

 Make sure that the “Surfaces” list is populated with at least one Surface object. If the current 
job already has a Layer object containing measured points, they will automatically be 
converted to Surface objects and displayed in the “Surfaces” list.  Such surfaces are labeled 
as Layer surfaces. 

 Surface objects can be added by importing points from an XYZ file as described in 
section 6.5.3.3 above.  Such surfaces are labeled as Imported surfaces. 

 Surface objects may also be added on the dense point cloud as described in section 6.5.3.2 
above.  Such surfaces are labeled as Cloud surfaces. 



 

 
 

- 76 - 

 All surfaces will also appear in the “Base Surfaces” dropdown list. In the “Surfaces” list, 
using the checkboxes in the left column, check the surfaces to be displayed. Revise them and 
determine if they are ready for volume calculation. 

 The following user interface controls can help during the visually scanning of the surface 
prior to calculating the volume. 

o If a point is identified as erroneous, it can be deleted by performing the following 
steps: 

 Hover over the point; the point name is displayed. 

 Zoom in to the point. 

 Right click on the point. 

 Click on Add to Delete Queue, if this is the first point you mark for deletion it 
will also open the “Delete Points” dialog, where you can see and edit what you 
plan on deleting. 

 Once you are done, Click on Delete Points to delete all points in the list (Figure 
83). 

 

Figure 83: Deleting the Selected Points 

 After a surface is selected (from the “Surfaces” list), click on Calculate Volume or add a 
base surface from the “Base Surfaces” list to the calculation and then click Calculate. The 
surface volume is calculated and displayed in the “Calculated Volume Properties” window 
(Figure 84). 
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Figure 84: Calculated Volume Properties Window 

 If only one Surface is used for the volume, the “Calculated Volume Properties” window 
shows the surface used for the volume calculation. If two surfaces (surface and base surface) 
are used for the volume calculation, both surfaces will be displayed in the window. 

The window shows the Fill and Cut calculated values in the measuring unit used throughout the 
job (m3 or ft3). 

Throughout this document: 

 

“Fill” refers to the amount of material accumulated above the base ground level. 
“Cut” refers to the amount of material subtracted below the base ground level. 

 To name the volume, as it will be seen in the “Volumes” list, in the “Calculated Volume 
Properties” window add a name. The calculated volume can be added to the “Volumes” list 
by clicking Add to Volumes. The volume is added as a new record to the list of volumes. 

 When all volume calculations are completed and added to the “Volumes” list, a volume 
report can be exported. Two types of file formats can be exported: PDF and CSV. From the 
“Export File Format” section, select the desired format and click Export…. 
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Figure 85: Volume Calculation – PDF Report 
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6.5.3.5 Possible Actions on Surfaces 

Several functions can also be utilized on surfaces to enhance volume calculations. 

Changing Surface Proprieties 

 To change surface properties, right click Surface in the “Surfaces” list to access its context 
menu. Select Properties. 

 In the “Surface Properties” window modify the Surface name, description and color. 

 

Figure 86: Surface Properties Window 

Exporting Collected Points on a Surface 

 To export point collected on a surface, right click Surface in the “Surfaces” list. 

 In the context menu, select Export to Points File…. A window opens.  

 Define the file location and name, and a file is saved in ASCII format with XYZ coordinates. 

Removing a Surface from the Surfaces List: 

 To remove a surface from the “Surfaces” list, right click Surface in the “Surfaces” list to 
access its context menu. 

 Select Delete. 

If the Surface is based on a Layer, this menu option will be grayed out and may not be 
used. Only imported and cloud surfaces can be deleted. 

Cloning a Surface 

 To clone a surface point collected on a surface, right click Surface in the “Surfaces” list, and 
select “Clone…”. 

 In the “Add Surface” shown select where you want to save the cloned surface and its 
properties.  

Setting a shared height for a Surface 

 To flatten a surface by setting the height of all its points to a common point, right click 
Surface in the “Surfaces” list, and select “Set shared height…”. 
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 Select the desired height from the available options, and click OK.  

 Be extremely careful when you use this option, as it will change the height in the 
defined surface.  Meaning that this should most likely be done on a cloned surface. 

 

6.5.3.6 Possible Actions on Calculated Volumes 

Additional functions can also be utilized on calculated volumes. 

Changing Volume Properties 

 To change volume properties, right click Volume in the “Volumes” list to access its context 
menu. 

 Select Properties... The “Calculated Volume Properties” window opens. Here you can 
modify the volume name. 

 

Figure 87: Calculated Volume Properties Window 

Recalculating a Volume 

 To recalculate a volume, right click Volume in the “Volumes” list to access its context menu. 

  Select Recalculate…. This option lets you update the volume value in the event that one of 
the surfaces involved has been changed. The “Volume Recalculation Properties” window 
opens letting you view the changes in the volume values. 

 Update the value for Volume or leave it as is. The date and time where the last calculation 
was made is also displayed. 
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Figure 88: Volume Recalculation Properties Window 

Removing a Volume from the “Volumes” List 

 To remove a volume from the “Volumes” List, right click Volume in the “Volumes” list to 
access its context menu. 

 Select a particular volume and then click Delete. The volume will be removed from 
“Volumes” list. 
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7 DatuSite™ Menu Options 
This chapter explains some of the menu options when their use is not self-explanatory or items 
that have not been previously explained in this document. 

7.1 File Menu 

7.1.1  Save as… 

The function saves the current job under a new name. The user continues to work with the 
newly saved job and if changes are made to the newly-named job the previous version is not 
affected.  

7.1.2  Export 

This is similar to the “Save as” function except that the current job is saved under a new name 
and (optionally) format (for Export) while the user continues to work on the current job. 

7.1.3  Close & Archive Job 

This is similar to the “Close Job” function except that it performs a temporary file cleanup to 
free disk space. This option should be used when the project has been completed. “Close Job” 
does not clean up temporary files, hence opening the job next time will be faster that after “Close 
& Archive Job”. 

7.2 Tools Menu 

7.2.1  Settings Window 

The “Settings” windows provide control over basic configuration settings for DatuSiteTM. 

To access the “Settings” window, click Tools > Settings. 
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7.2.1.1 General Settings 

 

Figure 89: The General Settings Window 

The Working Folder is the location where DatuSiteTM stores its temporary data. In order for 
DatuSiteTM to perform properly, its working folder should be located on a local drive (SSD is 
preferred), and not on network drive. 

In some computers associated with networks, it is common for folders that contain 
users’ documents to reside on network storage by default. For regular documents (word 
processing, working sheets, etc.) this is quite acceptable but it will not foster effective work 
with DatuSiteTM. DatuSiteTM performs a vast number of image and mathematical processing and 
needs a fast storage device. Only local storage devices can provide sufficient performance 
results. Because of this, it is recommended that the DatuSiteTM working folder resides on a local 
drive. An SSD is recommended. 
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7.2.1.2 Measurement Units 

 

Figure 90: The Measurement Units Window 

In the “Distance units” dropdown box, the following measurement units can be selected: 

 Meter 

 US Foot 

 International Foot 

 Yard 

In the “Volume Units” dropdown box, the following measurement units can be selected: 

 The distance units "Meter" can work with volume units of “Meter” only 

 The distance units "US-Foot" can work with volume units of either “US-Foot” or “Yard” 

 The distance units "Int. Foot" can work with volume units of either “Int. Foot” or “Yard” 

Click OK to set the measurement unit for the whole job. 
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7.2.1.3 Accuracy Display 

 

Figure 91: The Accuracy Display Window 

Set the range of residual measurement errors (green, yellow or red) as displayed in the 
Quality Control report (as a fraction of meters). 

7.2.1.4 Interior Orientation 

 

Figure 92: The Interior Orientation Window 
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Modify the information in this table in order to change measurements used by DatuSite™ to 
establish residual values. 

7.2.1.5 SBA 

 

Figure 93: SBA Window 

In the “Geo-Ref / Scale” window, click Apply to modify which points will be used in the SBA 
(Sparse Bundle Adjustment) calculation Caution should be used when setting these options 
as, although they will improve the accuracy of the model, they may slow the process of 
calculations. 

7.2.1.6 Advanced 

This tab is used to set advanced software options as shown in the figure below. 

 

Figure 94: Advanced Settings Window 

7.2.2  Managing and Using Codes and Blocks 

Codes and blocks are attributes of map entities used in most common surveying CAD software. 
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7.2.2.1 Managing Codes 

Code is metadata associated with a map entity that relates it to a specific family of entities. For 
example, code could indicate that a specific new-point entity is part of the entities related to 
mapping window frames or semaphores. A code has a name and a description. Each map entity 
can have only one code. 

In DatuSite™ each new-point entity has an associated code. By default, a new point has the code 
named “0” with description “Default”. You can change the new-point code to one of the codes 
that exist in the job’s codes library. In order to have codes in the codes library, you must load 
its commonly used list of codes from the job. 

Working with the “Point Codes Library” Window 

 To access the “Point Codes Library”, click Tools > Point Codes Library. The following 
functions are available: importing a codes library file, exporting a job’s codes to file, creating 
a new code, editing an existing code or deleting one. 

 

Figure 95: Point Codes Library Window 

Importing Codes Library File 

 Click Import. 

 Select the codes library text file. Figure 96 shows an example of an importable point code 
text file. 
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Figure 96: Point Code File 

 Confirm the import. 

 

Figure 97: Point Codes Loaded from Codes Library File 

If the system encounters names of existing codes, the “Naming Conflict” dialog box 
offers options to skip, rename or overwrite the point. 

Exporting Job’s Codes to a Text File 

 Click Export. 
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 Type the name of the file to hold the exported codes library. Output file format will be as 
shown in Figure 96. 

 Confirm the export. 

Creating new Point Code 

 Click New. 

 

Figure 98: Add New Point Code Window 

 Type the name and description for the new code. 

 Click OK. A new point code is added to the job’s codes library. 

Editing an Existing Point Code 

 From the point codes list, select the code you wish to change. 

 Click Edit. 

 

Figure 99: Editing an Existing Point Code –Edit Point Code Window 

 Edit the name and/or description of the code. 

 Click OK and the changed code values are saved. 

Deleting an Existing Point Code from the Job’s Codes Library 

 From the point codes list, select the code you wish to delete. 

 Click Delete. 
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Using Blocks 

A Block is the unit used by surveying software applications to store metadata associated with 
mapping entities and the graphical symbol representation of the entity. Thus, a block is a data 
structure that combines an icon and metadata attributes. In DatuSite™ blocks are used when 
the surveying map is exported to DXF format. 

Each new-point entity is associated with a block that has the same graphics symbol and the 
following attributes: 

Attribute Number Attribute Name Attribute Data Type 

1 Point Name text 

2 Point Comment text 

3 Code Name text 

4 Code Description text 

5 North double 

6 East double 

7 Elevation double 

8 Accuracy North double 

9 Accuracy East double 

10 Accuracy Elevation double 

11 Measurement Unit string 

7.2.3  Client License Manager 

This option is available only when a network license is used and permits a user to borrow a 
network license that is not in use for a period of time. If not done previously, when the time 
period expires the license is returned to the network server automatically. 

 Borrowing and returning a license can be done only while no job is open. 

7.2.3.1 Borrowing a Network License 

 To borrow a network license select the menu option “Tools/Client License Manager” 
(Figure 100). An external application will start and display a list of products that are 
available (Figure 101). 
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Figure 100: Client License Manager 

 

 

Figure 101: Borrowing a Network License 

 If there are no licenses available (Figure 102Figure 102), log out of the DatuSite™ 
application on one of the computers where it is running in order to release a license. 

 Click Refresh to see the list of available products again. The release process may take up to 
a few minutes. 
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Figure 102: No Licenses Available 

 If Datumate software licenses are available simply select one, set the Borrowing time 
duration to any number of days from 1 to 14, and click on Borrow License. From this point 
DatuSite™ will be using a local borrowed license, and the license will not be available on the 
network for other users. If you set a borrowing duration time that takes you beyond the 
license expiration date, the expiration of the borrowed license will be set automatically to 
the license expiration date. 

7.2.3.2 Returning a Network License 

There are two ways a borrowed license can be returned and made available to other users as 
follows: 

 Automatically when the time set for the borrowing period expires, even if the borrowing 
computer is connected to the network or not. 

 Manually by the user. This option requires accessing the “Client License Manager” 
application (Section 7.2.3 ) using the return license option (Figure 103). 

 

Figure 103: Returning a Network License 
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7.2.4  Generate Dense Point Cloud 

When available, this option allows the generation of dense point clouds for all clusters. When 
Dense Point Clouds are generated they override any previously generated clouds. When this 
option is selected, the DPC Parameters window will open to allow selecting all the different 
options including density level and output type.  

 

Figure 104 - Dense Point Cloud Parameters 

7.3 View Menu 

7.3.1  Point Cloud 

The menu option allows you to open the Point Cloud display and to move between clusters 
(Figure 105).  It displays the most recent point cloud available; Sparse or Dense.  
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Figure 105: Sparse Point Cloud Window 

Additionally, it allows you to export the points of any cluster to an external .ply file that can be 
opened using other software packages, such as “Cloud Compare” and “MeshLab”. 

7.4 Help Menu 

The following sections present the main Help menu options. 

7.4.1  About DatuSite™ 

Clicking About opens the “About” window. This window shows the product Name, Version, 
License information, and other applicable messages. Figure 106 is displayed if you have a valid 
perpetual license with a maintenance agreement that expires in more than 30 days. 
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Figure 106: About Window – Valid Perpetual License 

The “About” window will give proper messages if the license has expired or about to expire.  

If the time-based expiration was detected at startup, the system will present a notification 
(Figure 107) and will not allow you to continue, unless you have a new license ID that you want 
to update, in which case you may click the “Update License” button and update the license ID 
and key. 

 

Figure 107 – Expired License Message 

7.4.2  Checking for DatuSite™ Software Update 

Click on “Check for Update”, so that DatuSite™ will communicate with Datumate’s server to look 
for a newer version of the application. If a new version is found and you have a valid 
maintenance agreement, DatuSite™ will inform you that a newer version exists and it can be 
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downloaded (Figure 108). Follow instructions to download and save the installation file. After 
the installation file is downloaded, the installation starts automatically. 

 

Figure 108: Software Update Window 

If a new version is found and you do not have a valid maintenance agreement, DatuSite™ will 
inform you that a newer version exists and it can be downloaded (Figure 109). 

 

Figure 109: Version Available But No Maintenance Agreement Message 

If the most recent version is installed, an appropriate notification is displayed (Figure 110). 

 

Figure 110: Version Up-to-Date Message 

7.4.3  Opening the Welcome Screen 

 Click on the Welcome Screen to open the “Welcome” window. 
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Figure 111: Welcome Screen 

The “Welcome” window is divided into three columns: 

Left Column – Mini Jobs Manager: The left column is the Recent Jobs manager. Clicking on the 
Start button, in the top square, opens the help menu that has a Start button which activates the 
“Job Properties” window used to create a new job. 

The bottom square contains a list of links with names of recent jobs. Clicking on a link will open 
the linked job. Clicking the Open Job button will open a file dialog to let you select and open an 
already existing job. 

Middle Column – Video Tutorials: The middle column contains internet hyperlinks to 
DatuSite™ video tutorials. Clicking on each Play button will open the appropriate video in the 
system’s default browser. This feature requires Internet connection and the latest version of 
Flash Player, or using the Google Chrome browser. 

Right Column – Sample Jobs: The right column contains links to several guided sample jobs, 
stored on the Datumate’s server. To use and learn from a sample job, download the job from 
Datumate’s server to your PC (click Download), and click Open, to view the job within 
DatuSiteTM. Follow instructions in the manual to work with these jobs. 

7.4.4  Basic Steps Presentation 

 Click on Before You Start to open a series of pages containing explanations about the basic 
steps for using DatuSite™ (Figure 112 is the first slide of this series). 
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Figure 112: First Slide from Basic Steps Presentation 
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About Datumate 

Datumate is a leading vendor of geodetic expert systems. Datumate’s software products, which 
incorporate technological innovation and geodetic expertise, support land surveyors 
worldwide by improving productivity of field personnel, quality control and management of 
surveying project. Among Datumate’s customers are the Survey of Israel, Israel’s national 
mapping agency, as well as numerous leading land surveying firms worldwide. 

To learn more, please refer to: www.datumate.com 

 


